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I

PREFACE

want to say a very big THANK YOU for purchasing my eBook. I have been
teaching myself photography for over 2 years now through a lot of trial and error
and have put together this eBook to help save you some time if you’re just starting
out in photography or are looking to improve your photography skills. I strongly
believe that if I can achieve the level of progress I’ve made in 2 years, then you too,
can do it.

Although this eBook is titled The “Blogger” Photographer, you’ll find that the
ideas shared are not limited to bloggers alone but will be applicable to photography
in general.

Using images and real life examples; I will be sharing details of my photography
kit, camera settings, editing software used and quick cheats to achieve certain
moods as well as a bonus chapter which covers branding, social media and where
and how to contact the brands you love for collaborations and sponsorships.
Without further ado, let’s get right into it.
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THE	KIT

always say the most important equipment you need to learn photography is a
camera. It doesn't have to be an expensive one to begin with. The key is practicing
with what you can afford while saving up for your desired camera. There's no point
buying an expensive camera and not being able to put it to good use. These days a
lot of phones have the ability to take great pictures. So, less emphasis on the make
or model of the camera and more emphasis on developing your photography
technique which only comes about through continuous practice. Having said that,
I'll share what currently makes up my photography kit as I get asked this question a
lot.

CANON 5D MK III - This happens to be a professional level full-frame camera
offering 22.3 mega pixels. Cost wise, it is a bit on the higher side of the spectrum
starting at around £2,000. Prior to owning this I learnt with a basic entry level
camera (Canon 600D) which retailed at £350. Please bear in mind that you don't
have to buy these equipments brand new as you can save hundreds of pounds
buying used products. My entry level camera was put to good use as I practiced
taking pictures all the time. It was not until I felt that I had understood the
mechanics behind it and improved my techniques significantly before saving up to
buy my current camera.

CANON 50MM F1.8 LENS - I always encourage people to buy a camera with detachable
lens as the lens tends to make all the difference in the world. A good example of
this is DSLRguide who uses the Canon 600D with lenses that capture amazing stills
and motion. The lens comes with an option to shoot in either automatic or manual
mode. I tend to always shoot using the manual mode. It is a good lens to begin with

https://www.youtube.com/user/DSLRguide


and retails for less than £90.

CANON REMOTE CONTROL - I tend to use this for self portrait. It is not a must buy item as
most cameras usually have inbuilt self timers. So if you don't fancy running back
and forth to your camera then it is a good option to have.

Let’s play a game of spot the remote

TRIPOD - Again, I use this for self portraits as well as recording videos and taking
landscape shots. It's great to have if you plan on taking long exposure shots.

TEDDY BEAR - Yes, a gigantic teddy bear. This is the secret to my successful self



portraits. I place the teddy in the position I intend to pose for the shoot and focus
on it. I then take some test shots to verify that it’s actually in focus before
assuming its position for a shoot. If you don’t always have someone readily
available to assist with a shoot, you can always practice shooting yourself. Sure it
might take a little longer to achieve the desired look, but with continuous practice
it’ll get easier and easier.

WACOM INTUOS PRO (SMALL) - The Wacom tablet is one of my favourite tools. It
comes with a pen that allows for better precision when editing photos thus
improving your workflow. It is something I'd encourage any professional
photographer to possess. It currently retails at just under £200. There are quite a
few models and brands which could be purchased for cheaper.

Edited using the Wacom Intuos Pro tablet



ADOBE PHOTOSHOP - It's always important to try and capture the ideal shot when
shooting with camera settings, lighting and location. But this isn't always the case
which makes posts production key in achieving a desired look. Photoshop is the
software I currently use for all my photo editing. I particularly love it because it
allows for a non destructive workflow as you can work in layers. You can achieve a
lot in post production using Photoshop which also comes with Adobe Camera RAW.
Again, it is a software I would recommend that professional photographers have.
The software comes at a price. You have the option of paying a monthly
subscription fee of £8.57 or £102.30 annually. Both subscriptions come with Adobe
Lightroom. To begin with, I recommend you take advantage of their 30 day free trial
which will allow you to get a feel for the software and see if it's something worth
investing in.

If you currently shoot using your phone then fear not cause I’ve got you covered
when it comes to editing. There are a long list of free software you can use to edit
your pictures. My favourites include VSCOCAM and Snapseed. You can also use
Lightroom mobile and Photoshop mobile using the free 30 day trial period. I have a
blog posts that details how I take and edit pictures using my phone which you can
find here.

http://mossonyi.com/2015/10/take-stunning-pictures-with-your-phone/


Image shot on iPhone and edited with Snapseed and VSCOCAM

SUMMARY

You only need a camera to begin learning photography
Practice with the tools you have to improve your techniques before
investing in more expensive equipments
Use photo editing software to achieve a professional look
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CAMERA	SETTINGS

he best way to get the most out of your camera is to understand how it works.
Shooting using automatic mode is not the way to go if you’re looking to improve
your skills. Before buying both of my cameras, I did quite a bit of research on their
capabilities and this had a lot to do with understanding the camera settings. I would
spend a lot of time watching Youtube tutorials on how to operate the camera so
when I finally purchased it I could dive straight into using it.

When it comes to camera settings, I always shoot in manual mode and RAW as
that's the only way you can have full control over your images especially in post
production. In order to do this, you’ll need to have an understanding of the
relationship between ISO, Aperture and Shutter Speed as well as know what it
means to shoot RAW.

WHAT IS ISO?
In simple terms, ISO is the level of sensitivity of a camera to available light. The

lower the ISO number, the less sensitive a camera is to the light, and the higher the
ISO number, the more sensitive a camera is to light. The component within your
camera responsible for changing sensitivity is known as the “image sensor” or
“sensor”. It is known to be the most important and most expensive part of a
camera. It works by gathering light and transforming it into an image. With an
increased ISO number, your camera sensor can capture images in low-light
situations without having the need of a flash. But this comes at a price as it gives
rise to noise/grain in an image. I usually tend to keep my ISO at the lowest setting
(100) if I can help it in order to obtain a finer image.



Image containing noise/grain shot at f/2.8, ISO 1000 and shutter speed 1/100

WHAT IS APERTURE?
Aperture is an opening through which light travels. It is the opening in the lens.

In photography, it is measured in something known as "f-stops". If you recall
clearly, my lens in the previous chapter had it's highest f-stop in the name (50mm
f1.8).

With Aperture, the case is the reverse of ISO when it comes to numbering. A
lower f-stop number would be referred to as a higher Aperture and vice versa. The
Aperture that you set impacts the size of the opening in the lens. Using my lens as
an example, the higher the Aperture (f1.8), the more light that gets in. The lower
the Aperture (f22), the less light that gets in.

Aperture is known to give dimensions to photography. It is responsible for
creating "depth of field" sometimes referred to as "bokeh". In simple terms,
blurred background. A shallow depth of field can be achieved using a higher
Aperture (f1.8 - f3.5). I tend to use these setting a lot when trying to focus on a
subject.



Image with shallow depth of field shot at f/2.2, ISO 100 and shutter speed
1/100

WHAT IS SHUTTER SPEED?
Shutter speed is the length of time a camera shutter is open to expose light into

the camera sensor. In other words, exposure time. Shutter speed is usually
measured in fractions of a second and seconds. For example 1/4 means a quarter of
a second, while 1/250 means one two-hundred-and-fiftieth of a second or four
milliseconds. If the shutter speed is slow (e.g. 1/4), it means the camera sensor is
exposed to more light. A lower setting can result in motion blur. A faster (e.g.
1/1000) shutter speed means the sensor is exposed to less light allowing subjects to
remain in focus.



Image with low shutter speed shot at f/2.8, ISO 250 and shutter speed 1/125

WHAT IS RAW?
RAW is a camera file format that records all image data collected by the sensor

when a photo is taken. This means that no compression takes place allowing you to
produce higher quality image in post production as opposed to a compressed JPEG
file format.

One way to look at is, if you were served a really salty pie which was very difficult
to consume due to the intensity of the sodium, you’d; a) be forced to eat the pie as
it is with much discomfort, b) drink a lot of water to neutralise the taste or c) stop
eating the pie altogether. Think of this already baked salty pie as JPEG. On the other
hand, if you were given all the ingredients to make the pie, you’d mix the
ingredients and if it tasted too salty for your liking you could add more vegetables
or mushrooms to neutralise the excess salt before putting it in the oven to bake. In
other words, you get to bake the pie just how you like it. Think of the ingredients
you were given to bake the pie as RAW.

Most DSLR cameras have both RAW and JPEG file formats available. Bare in
mind that RAW files tend to take up a lot more memory compared to JPEG. I’ve also
come across mobile phones that have the capability of shooting RAW. A few phones
that can capture RAW photos include Samsung Galaxy note 5 , LG G4 and V1o, and
Nexus 5X and 6P.

WHITE BALANCE

It would seem incomplete to talk about manual settings without touching a bit
on white balance.



This is a setting found on digital cameras. As the name implies, white balance is
the colour balance on a digital camera. The camera setting achieves this by adding
the opposite colour in order to bring the colour temperature (warm or cool) back to
neutral. For example, instead of whites appearing green or yellow in an image, they
should appear white after white balance has been applied correctly.

You can make adjustments to your camera’s white balance by selecting the
appropriate option (auto, daylight, cloudy etc.). Some cameras will give you an
option to set the white balance manually. You can do this by taking a picture of a
white card, select the white balance manual option and set it to the photo of the
white card. This basically tells the camera what white should look like.

If you’re like me and sometimes forget to adjust the white balance settings, fear
not as this can be corrected in post production which I’ll touch upon in the next
chapter.

MY CAMERA SETTINGS:
As mentioned earlier, I always shoot RAW together with manual mode settings. I

usually start off adjusting the ISO to 100, followed by the Aperture to my desired
setting (usually between f1.8-f3.5) then the shutter speed (never below 1/100)
depending on the lighting.

In low light settings I always increase my f-stop to the highest (f1.8), leaving the
shutter speed at 1/100 and then adjusting the ISO to a point where grain isn't very
visible. To get the best image quality, I tend to make good use of natural light
during the day and avoid shooting at night as I don't own a flash.

In increased lightings, I usually set the Aperture to f3.5, ISO to 100 and then
reduce my shutter speed to allow for less exposure time (usually ranges from 1/100
to 1/2000).

To see ISO, Aperture and shutter speed in action I’d recommend watching this
video by Tony & Chelsea Northrup.

SUMMARY

Get to know your camera
Shoot RAW
Use manual settings

https://www.youtube.com/watch?v=F8T94sdiNjc
https://www.youtube.com/user/VistaClues
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POST	PRODUCTION

s much as I love taking pictures, editing seems to be my favourite part of the
process as I get to try out different techniques in order to achieve a certain look. It
allows me to be very creative which is why I love it. Editing can make or break a
picture which is why I’d say it is a very important part of photography as it gives
the finished look.

When it comes to editing in Photoshop, there's a lot that can be achieved using
different techniques. Discussing it's endless capabilities is not the aim of this
eBook but merely to make you aware of some of its functions which you can apply
when working on your images. In order to do this, I've decided to share my
workflow which will cover the adjustments I make use of when editing an image. 

In the past I edited my images to achieve different moods and looks. I've since
evolved to taking a more uniformed approach which is what I'll be sharing with
you. 

Current Image Edits

As mentioned in the first chapter, Photoshop is my go to editing software. I
particular love it because you can work non destructively as it allows you to work in
layers through duplicating the image a number of times and applying different
settings and or filters to create a number of effects when arranged a certain way.

http://www.instagram.com/mossonyi


Example of working in layers in Photoshop

At this point I’d like to point out that if you’re not familiar with Photoshop then
you should watch this video by Terri White which is basically a Photoshop guide for
beginners.

ADOBE CAMERA RAW

One of the first tools to get familiar with in Photoshop is the Camera Raw Filter
which shares the same capabilities with Adobe Lightroom. To access this tool,
select an image layer, go to “Filter” located at the top bar and select “Camera Raw
Filter” from the list.

Camera Raw Filter selection

For future references, making selections will appear in this format; Filter > Camera
Raw > Filter. This will bring up a screen that will allow you make adjustments to an
image.

The first thing I do is adjust the white balance if needed. I do this by dragging the

https://www.youtube.com/watch?v=OjRqZiAgoHo
https://www.youtube.com/channel/UC-oYkx9wyeGc6Sh8tkVlaTw


Temp and Tint slider left or right depending on the image. Dragging the Temp
slider to the left (blue tone) will give a cooling effect to the image while dragging it
to the right (yellow tone) will give it a warmer effect. Dragging the Tint slider to the
left introduces some cyan to your image and dragging it to the right adds magenta. I
tend to play around with the Tint slider until I’m happy with the results.

White Balance and Exposure sliders in Adobe Camera Raw

The next thing I like to do is to adjust the exposure of the image. Every image is
different and some might not require exposure adjustments. To increase exposure
drag the Exposure slide to the right and to the left to decrease. I usually don’t adjust
the contrast. I tend to adjust the highlights depending on the effect of the
exposure. I also play around with the Shadows, White and Black sliders till I’m
happy with the effect.

Because I tend to go for a desaturated look, I usually reduce the Vibrance by
dragging the slider to the left (no more than -20). You can also desaturate an image
by dragging the desaturation slider to the left.

Vibrance and Saturation Sliders in Adobe Camera Raw



My favourite adjustment in Adobe Camera Raw is the HSL/Grayscale. HSL stands for
Hue, Saturation and Luminance.

Hue, Saturation and Luminance in Adobe Camera Raw

Hue makes adjustments to the individual colour tones which range from Reds to
Magentas. I tend to only adjust the Reds, Oranges and Yellows in Hue to correct my
skin tone. It might take some playing around with to achieve the desired colour
tone. I then proceed to Luminance which is great for giving yourself a bit of a tan. I
tend to only adjust the Reds, Oranges and Yellows by dragging the sliders to the left
to achieve a tanned look. The final adjustment is Saturation. I usually make
adjustments to every colour. I always increase (drag slider to the right) the
saturation on the Reds and Oranges then reduce the saturation for every other
colour.

SELECTIVE COLOURING

To access level adjustment, select Layer > New Adjustment Layer > Selective
Colour > OK.



Solid Colour Layer

I love selective colouring as it allows you to achieve some incredible colour
grading. I tend to only make adjustments to the Whites, Neutrals and Blacks
channels but you can get amazing results playing around with the other colour
channels. Below is a before and after of an image where I adjusted all the colour
channels.

Before and After Selective Colour Adjustments

Each colour allows you to make adjustments to the the Cyan, Magenta, Yellow
and Black contained within it.



Selective Colour Channels and Sliders

Each of these colours have opposites which you can see when you drag the
sliders to the left. Dragging the Cyan slider to the right will add Cyan to the selected
colour while dragging it to the left will add Magenta.

LEVELS 
To access level adjustment, select Layer > New Adjustment Layer > Levels > OK.

Levels Adjustment

You can achieve additional colour grading here as well. I tend not to do colour
grading here as I already do that using selective colour. I only use it to adjust the
contrast. I do this in the RGB channel by playing around with the sliders till I
achieve my desired look. If you would like to achieve colour grading I’d suggest
going into the individual channels (Red, Green and Blue) to make adjustments.



Access to Red, Blue and Green Channels in Levels

SOLID COLOURS 
To access solid colour adjustment, select Layer > New Fill Layer > Solid Colour >

OK.

Solid Colour Adjustment

This will bring up a colour board and a slider which you can move up and down to
see the colours.



Colour Board

This is the final adjustment I use to give my images  a finished look. I tend to
stick with the same colour so that my images have a distinct and unified look. I
tend to use a desaturated blue colour and then reduce the opacity to 40% with the
blending mode set to lighten. You can always bring up the colour board and select a
different colour if you’re not happy with your initial choice.

Blending Mode

Coming up with your own unique edit will take a lot of trial and error which only
comes about by practicing. You can always play around with all the available
adjustments in New Fill Layer and New Adjustment layers to see what looks you
come up with.

QUICK CHEATS

If you're still struggling to get a hang of how to edit using Photoshop, don't you
worry cause I've got something that'll save you a whole lot of time and thinking -
Presets. A lot of sites offer presets you can download for use in Photoshop (Camera



Raw) and Lightroom. They're super easy to use. It's just like applying filters to your
photos. 

My tried and tested presets that I always love recommending is VSCO Film. VSCO
Film currently offers 7 packs (01-07) with each containing at least 18 presets.
There's also an additional pack called Film Essentials which is basically a selection
of the best and most popular films from each of the 7 distinct VSCO Film packs. All
retailing at $59 each. 

Some sites may offer free presets if you currently can't afford to buy the VSCO
Films. You can do a quick google search for free Photoshop/Lightroom presets and
you should get a few hits. One site that offers one is Nate Photographic. 

Once you've successfully downloaded a preset (they usually come with download
and installation instructions), you should be able to apply it to your desired image.
To access the presets in Photoshop, select Filter > Camera Raw Filter > Presets. You
can choose from the list to see which filter works best and make additional
adjustments in Camera Raw (e.g. adjusting the white balance and exposure).

Presets in Adobe Camera Raw

If you feel like the preset is too strong you can adjust the opacity to your desired
look.

https://vsco.co/store
https://vsco.co/store
https://vsco.co/store
http://natephotographic.com/vsco-cam-lightroom-presets-starter-pack/


Adjusting Opacity

You can also do additional colour grading using adjustment layers like selective
colour and levels.

My favourite pack is the VSCO Film 07 which has some awesome black and
white presets that I love using. I have started a black and white series on my blog
which will feature edits using this preset.

Images Edited Using VSCO Film Preset

TIP

One thing that assisted a great deal with improving my editing skills was trying
to recreate pictures I had come across. In order to do this, I follow photographers
that I love their work and try to recreate their image with my own twist to it. This
pushes me to try out different settings which has made me better at editing. It is
definitely something I’ll encourage that you do when practicing.

http://vsco.co/store/film/07
http://mossonyi.com/2016/12/new-series-my-week-in-black-and-white/
http://www.mossonyi.com


SUMMARY

Get familiar with editing software
Experiment by playing around with settings when editing
Use presets to save time
Practice recreating the work of others
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MY	BLOGGER	GUIDE

ell done on making it past the technical bits. You’ve now got what it takes to
go out and shoot your pants off.

As a blogger girl and one that had to find out a whole lot by myself I thought it
only fair to share a number of things I've learnt along the way which is why I've
decided to include this bonus chapter. I'll be sharing social media tips, what to
think about when creating a brand, where to find PR contacts and how to approach
the brands you love.

CREATING A BRAND

This is something I've had to learn. You have to sit down and think about what
you want to be known for and decide how you'll go about it. A lot of bloggers do this
by having a theme or a unique sense of style. A theme can be achieved by using the
same filter, being completely random or maybe something as simple as always
wearing a big old smile. Whatever your theme is, stick with it. We're all creatures of
habit and we love to know what to expect from a brand or someone we follow on
social media. If you manage to get someone to click the follow button, chances are
they are doing so because they like what you’ve shared so far. I'm not saying don't
grow or challenge yourself, I'm saying be consistent in a way that your work will
still be recognised.

I always knew that I didn't want to just be any odd blogger. I wanted to stand for
something else as well. After watching the TV show Fashion Bloggers, I made a
decision to pursue photography and use blogging as a platform to showcase my
work. It's no wonder I get a lot of questions concerning photography and why I'm
writing this eBook because I sat down and thought about what I want to be known

https://en.wikipedia.org/wiki/Fashion_Bloggers


for. If you don't currently have a clearly defined brand, my challenge to you would
be to sit and think about what you would want to be known for. Your thought
process should be “what do I want people to say when they hear my name/brand?”
That line of questioning should always point you in the right direction.

SOCIAL MEDIA ENGAGEMENT

Maintaining presence on social media can sometimes come across as a full time
job. I'll be the first to admit that I don't maximise this enough, but I'm working on
it.

Image does matter a lot so one of the first things to try and improve on would be
the quality of your images. There are so many bloggers out there and brands are
very keen to engage bloggers who deliver quality content. I say this from
experience. I don't have a huge social media following (my combined following is
circa 10k) but that doesn't stop brands from approaching me or agreeing to work
with me when I approach them. I strongly believe it has more to do with my
content than the number of followers I have. A good example of this is when I got
selected as 1 of 9 girls chosen to collaborate with a UK brand - Missguided out of
over hundreds of bloggers who applied for the opportunity.

It's also essential to have a description in your "about me" section or “bio” that
describes you and your work. The way to go about this is to first read what you
currently have up then scroll through your feed to see if what you've just read
matches the content of your feed. If it doesn't, go back and make changes to your
description and repeat the exercise until both align with each other.

For platforms like Instagram and Twitter, it's always good to have your email
address in the bio section as that's how brands and other people could try to reach
out to you. One feature Instagram now offers is a business profile which has a
contact button. To switch to the business profile, you need to have a Facebook
profile page that's connected to your Instagram account. I never use to have my
email address in my bio and consequently got quite a few comments from people
asking how they could contact me. I also seldom got approached by brands but this
is no longer the case since I made this subtle change. Taking me from 1 brand
collaboration in 18 months to at least 8 in a space of 3 months.

Also, using hashtags that are relevant to your work will get you engagement from

https://api.shopstyle.com/action/apiVisitRetailer?url=https%3A%2F%2Fwww.missguided.co.uk&site=www.shopstyle.co.uk&pid=uid8496-37810136-55


similar accounts who do what you do. Because hashtags usually look messy when
used in the main caption of a post (referring to Instagram in this instance) I usually
use them by commenting on the post. That way it's not visible once other
comments follow.

Using Hashtags to Comment on Instagram Post

The hashtags I use are #Blogger #Manchester #ManchesterBlogger
#TravelBlogger #YouTuber #Vlogger #UKblogger. These hashtags tend to get me a
lot of likes on my posts but not necessarily followers. I came up with them based on
what I presume brands would look out for when trying to work with bloggers in
certain locations. These hashtags have achieved their purpose as I went from being
invited to zero blogger events prior to using them to getting at least 3 invites a
month to attend Manchester and UK wide blogger events. This in turn has given me
the opportunity to connect with and establish relationships with other bloggers in
Manchester. Some of whom have become friends.

BRAND CONTACTS

One piece of knowledge I gained was joining Facebook groups where PR contacts
and bloggers engaged. A good one is UK blogger opportunities as there are
opportunities posted there on a daily basis. Because of the number of bloggers on
there, be prepared to strongly state why you should be considered for an
opportunity when applying for one as competition is high. You could also do a
search on Facebook for blogger opportunities in your area. I’m also currently part of
the Manchester Bloggers Facebook group.

https://www.facebook.com/groups/UKBloggerOpportunities/?ref=br_tf
https://www.facebook.com/groups/405261116261578/


A few other blogger opportunities sites that could be useful include:

The Blogger Programme
Bloggers Required
Type the Hype

Another way to work with brands is to contact them directly or go through their
PR company. You can get their contact details by tweeting the brand and asking for
their PR contact or doing a quick google search with the name of the brand and PR
contact afterwards. E.g. ASOS PR contact. Once you're in possession of their
contact details, send them an email stating who you are and what you do and why
you're contacting them. Try and do this in not so many words. Some people will say
mention your social following but I'd say only do this if you have a huge following. I
tend to stay away from my follower count as I don't have that many and instead
focus on the quality of my work by leading them to my blog and Instagram profile.

Here's an example of an email I sent out to a PR company asking to work with
one of their clients.

"Hiya (insert contact name),
We met at the Manchester blogger event hosted by (insert host name) in the

summer.
I'm a Manchester based blogger/photographer and I'm writing about a potential

collaboration with one of your clients (insert client's name) as I'm all about
affordable fashion and making the most of it.

The idea is to create some cosy looks with a couple of their knitwear collection
which would be shared on my blog and social media platform. Let me know if this is
something you’d be interested in.

Looking forward to your response. In the meantime please feel free to check out
more of my work on my blog - www.mossonyi.com and Instagram -
www.instagram.com/mossonyi.

Kind regards,
Onyi (@mossonyi)"

This usually tends to be the format of my emails. In this instance, the PR company
obliged my request and sent me the pieces of my choice.

Be prepared not to hear back from some of the brands you contact but that
should never put you off. I usually get a response 90% of the time with either an

https://www.thebloggerprogramme.com
https://bloggersrequired.com
http://www.typethehype.com
https://api.shopstyle.com/action/apiVisitRetailer?url=http%3A%2F%2Fwww.asos.com%2Fwomen%2F&site=www.shopstyle.co.uk&pid=uid8496-37810136-55
http://www.mossonyi.com/
http://www.instagram.com/mossonyi


offer of acceptance or a counter offer and on some occasions told there are no
opportunities at the moment. With regards to the latter, I always respond thanking
them for writing back and requesting to be added to their blogger database so I can
keep an eye out for future opportunities.

ENGAGE

Another way to catch the eyes of a brand would be to take part in their social
media campaigns. A lot of brands use hashtags to engage with their customer base.
Using these hashtags or tagging them could lead to being featured on their page.
For example, ASOS usually encourages their customers to use the #AsSeenOnMe
hashtag when wearing their pieces.

LET'S TALK COMPENSATION

Before going into details of how you can get compensated, it is worth
mentioning that when going into blogging, your reason for doing so shouldn’t
solely be to get free products/services as you might face huge disappointments. You
could find yourself agreeing to review products you don’t particularly like and
potentially come off as in-genuine to your readers. The industry is very competitive
and many successful bloggers make a living through various avenues after putting
in a lot of hard work into their blog. Success will be measured differently by
everyone but for me it has and will always be to deliver quality content and the rest
(thousands of followers, brand deals etc.) will follow.

When it comes to opportunities you'll find most of them will involve compensation
in the form of product or services being offered by the brand. Sometimes there
could be a chance you could be paid but you have to ask as some brands/PR
companies don't like to mention that. What you've got to think about is that many
brands are saving a huge amount on mainstream advertising and instead focusing
on blogger outreach. Think about it, if you see your favourite blogger wearing a
piece from ASOS, you might be influenced to purchase that same piece. PR
companies get paid to engage with industry influencers (bloggers being one of
them) and sometimes that involves a chance of payment. My blogger friend
phrased the question quite appropriately. She said, when contacted by a brand for a
collaboration, she sometimes responds asking if it's a paid opportunity. This is a
very polite way to ask. Sometimes they come back with an offer and other times

https://api.shopstyle.com/action/apiVisitRetailer?url=http%3A%2F%2Fwww.asos.com%2Fwomen%2F&site=www.shopstyle.co.uk&pid=uid8496-37810136-55
https://api.shopstyle.com/action/apiVisitRetailer?url=http%3A%2F%2Fwww.asos.com%2Fwomen%2F&site=www.shopstyle.co.uk&pid=uid8496-37810136-55


they state the compensation available is only in the form of products/services.
Don’t be afraid to use your judgement to accept or politely decline an offer.

I would only recommend asking for payment if you were initially approached by
the brand as writing to a brand and requesting to collaborate with them in exchange
for payment might be off putting.

INFLUENCER APPS

I recently discovered this. There are quite a number of agencies who pay
bloggers and other creators to post ads on their social media accounts in exchange
for monetary compensation. These agencies usually require you to have a decent
following and quality content as well.

I’m currently registered with Takumi who work with Instagram influencers to
create ads for their clients. I particularly like them because they don’t focus on
having huge followings but more on engagement and the quality of your content. In
order to join you’ll need a minimum of 1K followers and their minimum
compensation per post is £40 which could go up to hundreds and thousands
depending on your following and engagement. If you use certain hashtags like
#follow4follow, #likes4likes etc, you won’t be accepted on board so it’s best to read
their terms and conditions to make sure you meet their requirements before
applying to join. The only negative thing about Takumi that when an opportunity
involves you showcasing a product, you have to purchase the product yourself. The
products usually tend to be less that £10 so you’ll still be making a profit. The app is
only currently available in the UK and Germany but they aim to branch out in the
coming years.

A quick google search will pull out other apps that offer similar social media
campaigns. A couple of others I came across are Tribe and Tailify.

LINKS

Linking to products is another way to generate income as a blogger. There are so
many affiliate sites that you could join where you can create widgets and links for
your blog and social media posts. A quick google search will bring up websites that
offer such services.

My favourite at the moment which my blogger friend introduced me to is
Shopstyle Collective where you can earn per clicks regardless of whether or not a
purchase is made.

http://takumi.com/
http://takumi.com/
https://www.tribegroup.co/
https://tailify.com/
https://www.shopstylecollective.co.uk


BUILDING RELATIONSHIPS WITH BRANDS

Once you’ve been able to secure an opportunity to work with a brand you love, do
your absolutely best with the tools you have to deliver above expectation. This will
make you stand out and encourage future engagement from the brand. For
example, I was invited to a blogger event in Selfridges Manchester by a PR company
to meet the designer behind Ms Self Portrait. I took pictures and videos of the
events which I shared on my blog and Youtube Channel. It would appear that only
a few bloggers ended up putting in as much effort as I did and as such made me
stick out a bit. A couple of weeks later I was invited to another one of their events
and was sent a car with the loveliest driver who took me back and forth to the event
along with some treats.

KEEP THE CONVERSIONS GOING

After delivering on a project, be sure to maintain contact with the brand. You
can do this by sharing posts where you feature their products/services which
they’ve not sponsored. This shows that you truly love their work. Don’t be afraid to
approach them with collaborative ideas to see how you can continue to work
together in the future.

SUMMARY

Define your brand
Use purpose driven hashtags
Join blogger opportunities Facebook groups/sites
When contacting brands, introduce yourself, state the offer, lead them to
your work
Take part in brand social media campaigns
Don’t be afraid to ask if an opportunity is paid
Always deliver above and beyond expectation
Keep the conversation going

https://api.shopstyle.com/action/apiVisitRetailer?url=http%3A%2F%2Fwww.selfridges.com%2FGB%2Fen%2F&site=www.shopstyle.co.uk&pid=uid8496-37810136-55
https://www.instagram.com/mrselfportrait/?hl=en
https://www.instagram.com/mrselfportrait/?hl=en
http://www.mossonyi.com
https://www.youtube.com/user/mossonyi
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AFTERWORD

ongratulations on completing my eBook. It’s safe to say you’ve gained some
knowledge that you can now apply to your work as a photographer/blogger. As
much as I have shared with you what I’ve learnt on my journey, the task now rests
with you to put it into practice - “don’t just aim; take the shot”.

The key things to remember are;

The camera is the most important tool
Use editing software to achieve a professional look
Define your brand
Engage with brands you love
Go out and shoot shoot shoot

I’ll love to see the progress you make after completing this eBook and applying
the things you’ve learnt. Please keep me up to date with your progress using the
hashtag #TheBloggerPhotographer. I look forward to seeing your work. In the
meantime, come say hi on social media - Instagram, Twitter and Facebook.

Good luck!

http://www.instagram.com/mossonyi
http://www.twitter.com/mossonyi
http://www.facebookcom/mossonyi


ABOUT	THE	AUTHOR

Onyi Moss is a self taught fashion photographer/blogger based in Manchester, UK. Originally from Nigeria, Onyi
moved to the UK in her early twenties to pursue her career as a chartered accountant. She later discovered her
passion for photography which has seen her teach herself the art through a lot of trial and error. She uses her
blog as a medium to showcase her work and is excited to share some of the things she’s learnt along the way in
this eBook to assist others who are just starting out or simply having difficulty figuring out the basics. This is
her first of many books which she intends to write.

For more information:

 @mossonyi

 Mossonyi

www.mossonyi.com

mossonyi@gmail.com

http://www.mossonyi.com
https://twitter.com/mossonyi
https://twitter.com/mossonyi
https://facebook.com/Mossonyi
https://facebook.com/Mossonyi
http://www.mossonyi.com
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